
 

 

 

 
Server Redundancy Checklist v3.1.0 
Proficy HMI/SCADA – CIMPLICITY 
 
 

Primary Secondary  
 

 
Outline 
 
This document is intended to assist in the setup and basic troubleshooting for a CIMPLICITY HMI Server 
Redundant configuration.  The basic troubleshooting covers issues related to incorrect or inconsistent 
configuration settings on the primary and secondary computers that make up the redundant pair. 
 
NOTE:  
 
If you have a computer (either the Primary or the Secondary) in the redundant pair that has more than 
one Network Card then you must do further configuration than the Basic Redundancy Configuration.   
Please see the appendices following the Basic Redundancy Configuration/Troubleshooting for 
additional information. 

 
Basic Redundancy Configuration/Troubleshooting 
 
Step 1: Verify Licensing 
 

� The CIMPLICITY HMI System is running in 4 day mode (The system is not licensed and it is 
within 4 days of the initial installation of the CIMPLICITY HMI software) 
 

OR 
 

� The CIMPLICITY HMI System is properly licensed.  To be properly licensed, the following 
conditions must be met: 

 
1) The Primary and secondary computers should be running with the same hardware 

and operating system. 
2) Both the primary and secondary computers must be running the same version of 

CIMPLICITY HMI (including service pack and hot-fixes) 
3) The primary computer must have a valid Server Development License. 
4) The secondary computer may have a development license or Server runtime license. 
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5) All options configured within the project, including Server Redundancy, must be 
installed and licensed on both servers. 

 

Step 2: Verify Network Communications 
 

� The following information is needed for this step: 
 

1) TCP/IP address of the primary computer 
2) TCP/IP address of the secondary computer 
3) Hostname (Node name) for the primary computer 
4) Hostname (Node name) for the secondary computer 

 
 

� Test communications between machines using the Ping utility.   
 

Validate communications as follows: 
 

1) Open up a DOS command prompt on the Primary computer 
 

2) Execute a ping command by TCP/IP address from the Primary to the Secondary 
computer.  
 
Example: ping  <TCP/IP address of secondary computer> 

 
3) Open up a DOS command prompt on the Secondary computer. 
 
4) Execute a ping by TCP/IP address from the Secondary to the Primary computer. 

 
Example: ping <TCP/IP address of primary computer> 

 
5) From the DOS command prompt on the Primary computer, execute a ping by hostname 

from the Primary to the Secondary computer, verifying that the TCP/IP address returned 
by the ping command is the expected for the secondary computer. 

 
Example: ping –a <hostname of Secondary> 
 
If this fails please see the Appendix B: Name Resolution and configure the cimhosts.txt 
file on the Primary computer.  
 

6) From the DOS command prompt on the Primary computer, execute a ping by hostname 
from the Secondary to the Primary computer, verifying that the TCP/IP address returned 
by ping command is the expected address for the primary computer. 

 
Example: ping –a <hostname of Primary> 
 
If this fails please see the Appendix B: Name Resolution and configure the cimhosts.txt file 
on the Secondary computer. 

 

� Verify that the Startup Options are configured properly on both the primary and 
secondary computers. 

 
1) Open up the CIMPLICITY Options. 
2) Select the Startup Options tab.  
3) Verify that the Accept Connections checkbox is currently selected 
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Step 3: Secondary Only Configuration 
 

� Configure the directory for the CIMPLICITY HMI run-time project configuration on the 
secondary computer with the correct permissions. 

 
1) On the Secondary computer, stop all projects running using the CIMPLICITY Options utility.  

This can be accessed as follows: 
 

Start->Programs->CIMPLICITY HMI->HMI->CIMPLICITY Options 
2) Stop any running projects 
3) Determine the location for the CIMPLICITY run-time project configuration data.  The path 

name for the location cannot contain any spaces and the fully qualified path name 
should be 27 characters or less.   

  
WARNING:  Do not choose a location that within the directory tree of another CIMPLICITY 
HMI project. 
 

4) Create the directory at the determined location. 
5) Create a share name for the directory that does not contain any spaces.  The user on the 

Primary computer where the project is started should have full control over this directory.  
 

WARNING:  When you attempt to start the project from the Primary, it will use the 
username and password of the logged in Windows user who initiated the request for the 
start request to the Secondary For the newer Microsoft Windows Operating Systems 
(Windows XP or newer) it is required that the username and password is the same for 
both users on the primary and the secondary in a workgroup. Each user must have a 
password; you cannot have an empty password or the start request will fail. 

 
6) If you are using NTFS, configure the windows directory (i.e. C:\windows or C:\winnt), the 

system32 subdirectory (i.e. C:\windows\system32 or c:\winnt\system32) and the exe 
subdirectory under the CIMPLICITY installation directory (C:\cimplicity\hmi\exe) so that 
SYSTEM, NETWORK and the user account starting CIMPLICITY on the primary has full 
control. If the permissions are not sufficient, the secondary cannot be started from the 
primary. 

7) On Windows XP or Windows 2003, turn off Simple File Sharing.  
 
To turn off Simple File Sharing: 
 
a) Open Windows Explorer  
b) Go to Tools->Folder Options->View->Advanced Settings  
c) Uncheck Simple File Sharing 

 

Step 4: Primary and Project Configuration 
 

1) Open the project in the workbench on the Primary computer 
2) Uncheck Server redundancy in the project properties if it is already selected. 
3) Start the project and verify it runs properly when not configured for redundancy. 
4) Stop the project. 
5) Open up Windows Explorer and create a new mapped network drive to the shared folder 

created on the secondary for storing the CIMPLICITY configuration files used on the 
secondary.  The name should be something like <drive letter>:\ (i.e. f:\).  The device name 
should be \\computername\share, where the “computername” is the hostname and not the 
TCP/IP address.  
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NOTE: If you are using CIMPLICITY 7.0 or higher, then you do not need to create a mapped 
network drive, as you will need to use a UNC Path (Example: \\COMPUTER\Share\).. 

 
6) Go to the Project Properties, and add the Server Redundancy option.    
7) Select the Redundancy tab and enter the Secondary computer for the Computer name and 

the mapped drive name for the Project Path. 
 
NOTE: If you are using CIMPLICITY 7.0 or higher do not use a mapped network drive; instead 
use a UNC Path (Example: \\COMPUTER\Share\). If you are using Windows XP this is 
mandatory. 

 
8) If it isn’t selected, select the Basic Control Option from the project properties (this only applies 

to versions prior to CIMPLICITY 7.0).  
9) Press the Update configuration button in the workbench. 

 
NOTE: This causes the runtime data to be copied over to the shared folder on the remote 
system. After pressing this you should see the files start to appear on the Mapped Network 
Drive. If the files do not get copied then there is a network permission or configuration error. 

 
Step 5: Vista Specific Configuration 
 

If you are using CIMPLICITY 8.0 or higher, and are intending to use Windows Vista you may need to 
do additional configuration. If you are not using Vista or CIMPLICITY 8.0 or higher then skip to the 
following step. 

 
1) If you are using Workgroup Authentication (and not Domain Authentication) then you may 

need to change a Windows registry setting to allow this type of authentication. The following 
Microsoft article explains some of the additional configuration: 

 
http://msdn.microsoft.com/en-us/library/aa384423.aspx 
 
The following steps can be used to turn off the User Access Control security for configured 
Administrators.  This will allow a Workgroup Authenticated Administrator to be able to start 
the remote project on the Secondary. 
 
Using RegEdit go to the following registry location: 
 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Policies\System 
 
Create a new DWORD registry entry called “LocalAccountTokenFilterPolicy” 
When prompted for a value give it a value of “1”  

 
2) It is also required to start the Remote Registry Service on both Primary and Secondary so that 

the remote start requests can be handled. A service can be started via the Control Panel-
>Administrative Tools->Services. When the utility launches, find the service named “Remote 
Registry” and start it. The Startup Type should also be changed to “Automatic”. Click OK when 
done. 

 
 

Step 6: Starting the project 
 

1) Open up the project in the workbench on the Primary Server. 
2) Press the start button. When prompted between Primary and Secondary – choose Primary 

only. 
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3) Verify the project is working as expected with only the master started. 
4) Hit the run button again this time choose start slave only. The other two choices should be 

greyed out. 
 

NOTE: If you get an error saying that you do not have permissions to launch the secondary, 
then make sure that for the Windows Users that you are using there is a password configured. 
On newer OS releases, it is a requirement for remote authentication that each user has a 
password configured. 
 

5) Test the system running as host redundant and verify it functions as expected. 
 
At this point the system should be functioning correctly. 
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Appendix A: Cabling Redundancy and General Network configuration 
 
The following information describes many common network scenarios encountered.  It is 
recommended that this information be used in conjunction with the Viewer to Server checklist.  

 
DHCP 
 
It is not recommended that CIMPLICITY HMI be used on computers whose TCP/IP addresses are served 
by a DHCP server.  This is because the TCP/IP address may change when the lease expires.  Should this 
occur, the only recovery path is to stop and restart the CIMPLICITY HMI project/viewer on the computer 
whose address changed.  After restarting the system, the time for remote systems to detect the 
change and attempt to re-establish a connection is defined by the System global 
CONNECT_DROP_PERIOD.    The default value is 600 seconds (10 minutes). 

 
DNS and the CIMPLICITY HMI Router 
 
CIMPLICITY HMI may be used with DNS.  Should the TCP/IP address be changed, the recovery is as 
described above for DHCP. 
 

Server Redundancy - Single Ethernet card 
 
For server redundancy where the servers each have a single Ethernet card, configure the cimhosts.txt 
file to include the TCP/IP address of each server (local and remote servers).  The cimhosts.txt file is 
located in the etc sub-directory located off the CIMPLICITY HMI installation root (e.g. C:\cimplicity\hmi). 
 
Example: 
 
 

SERVER_1 SERVER_2  
 

TCP/IP Address Mappings 

Computer Name: SERVER_1 
 
Ethernet card 1: 10.1.1.1 

Computer Name: SERVER_2 
 
Ethernet card 1: 10.1.1.2  

 

cimhosts.txt Files 
 
SERVER_1 Cimhosts.txt file: 
 
10.1.1.2         SERVER_2 

SERVER_2 Cimhosts.txt  file: 
 
10.1.1.1        SERVER_1 

 
This does the proper association of computer name to IP address between the servers and should 
allow them to communicate properly. 
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Server Redundancy - Dual Ethernet card 
 

Single Ethernet card Broadcast 
 
When there are two Ethernet cards installed in the computer, but only one is desired for CIMPLICITY 
HMI server/viewer communications, a System Level Global Parameter called BIND_ADDR may be 
defined to declare which Ethernet card is to be used for broadcasts.  The value for the BIND_ADDR 
variable is the TCP/IP address assigned to the card over which the broadcasts should occur.  The 
cimhosts.txt file should also include an entry for the given server and bound TCP/IP address in each 
cimhosts.txt file that makes up the CIMPLICITY System (including the local server), and it should be 
updated whenever the address is changed on all computers that access the server (including itself). 
 
Example: 
 
 

`

Viewer

Server_1

External Network

NIC 2 NIC 1

 

TCP/IP Address Mapping 
Computer Name: SERVER_1 
 
Ethernet card 1: 10.1.1.1 
Ethernet card 2: 192.168.1.1 

Computer name: VIEWER 
 
Ethernet card 1: 10.1.1.3 

 
In this configuration, the system-level global parameter BIND_ADDR should be defined to be 10.1.1.1 
on the server so that it is able to communicate with the viewer.  Also, an entry in the cimhosts.txt file 
should also be created for the server for the same TCP/IP address. 
 
System Global Parameter Name: BIND_ADDR 
Value: 10.1.1.1 
 

cimhosts.txt File (Server) 
10.1.1.1         SERVER_1 
10.1.1.3         VIEWER 
 

cimhosts.txt File (Viewer) 
10.1.1.1         SERVER_1 
10.1.1.3         VIEWER 
 
If these changes are not made, the server will not be able to communicate with the viewer. 
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Cable Redundancy 
 
How it works: 
 
When a system is configured as cable redundant there are two physical paths (two cables) to any 
other Viewer/Server on the network. With cable redundancy, the Viewer to Server and Server to Server 
communication is concurrently transmitted on both Ethernet cards.  The receiving system will accept 
the first transmission received and will discard subsequent duplicates.  
 
How it is configured: 
 
On each system on the cable redundant network, there are two entries for each computer – one for 
each TCP/IP address.  On each computer, the two TCP/IP addresses need to be on different subnets. 
 
NOTE:  
 
To use Cable Redundancy communication on a server, a Server Redundancy option license is required 
on each server. The license is not required on a cable redundant viewer 
 
 
Example: Viewer to Server (Cable Redundant) 
 

Server_1

Network B

Network A

NIC 1

NIC 2

NIC 1

NIC 2

`

Viewer
 

 
 
 

TCP/IP Address Mapping 
 
Computer Name: SERVER_1 
 
Ethernet card 1: 10.1.1.1 
Ethernet card 2: 192.168.1.1 

Computer Name: VIEWER 
 
Ethernet card 1: 10.1.1.2 
Ethernet card 2: 192.168.1.2 

 
 
Resulting entries included in the cimhosts.txt file: 
 

Cimhosts.txt Files 
 
SERVER_1 Cimhosts.txt file 
 
10.1.1.1             SERVER_1 
192.168.1.1      SERVER_1 
 

VIEWER Cimhosts.txt file 
 
10.1.1.2             VIEWER 
192.168.1.2       VIEWER 
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10.1.1.2           VIEWER 
192.168.1.2    VIEWER 

10.1.1.1             SERVER_1 
192.168.1.1      SERVER_1 
 

 
 
Cable redundancy is not enabled if the cimhosts.txt file is not correctly setup on each system.  All cable 
redundant systems (including that of the local PC), need to be included in each cimhosts.txt file on 
each computer.    
 
A few examples are shown below: 
 
Example: Redundant Primary to Redundant Secondary (Cable Redundant) 
 

Server_1

Network B

Server_2

Network A

NIC 1

NIC 2

NIC 1

NIC 2

 
 
 
 

TCP/IP Address Mapping 
 
Computer Name: SERVER_1 
 
Ethernet card 1: 10.1.1.1 
Ethernet card 2: 192.168.1.1 

Computer Name: SERVER_2 
 
Ethernet card 1: 10.1.1.3 
Ethernet card 2: 192.168.1.3 

 
  
 
 

Cimhosts.txt Files 
 
SERVER_1 Cimhosts.txt file 
 
10.1.1.1             SERVER_1 
192.168.1.1       SERVER_1 
 
10.1.1.3             SERVER_2 
192.168.1.3      SERVER_2 

SERVER_2 Cimhosts.txt file 
 
10.1.1.3             SERVER_2 
192.168.1.3       SERVER_2 
 
10.1.1.1             SERVER_1 
192.168.1.1       SERVER_1 
 

 
 
. 
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Single Ethernet card Viewer on a Cable Redundant Network 
 
Not all viewers need to be cable redundant in a cable redundant configuration.  In the case of the non-
redundant viewer in the cable redundant configuration, the cimhosts.txt file should only show the one 
path for communications on the viewer. 
 
Example: 
 

Server_1

Network B

Network A

NIC 1

NIC 2

NIC 1

NIC 2

`

Viewer2

NIC 1

`

Viewer1

 
 
 

TCP/IP Address Mapping 
 
Computer Name: SERVER_1 
 
Ethernet: 
card 1:  10.1.1.1 
card 2:  192.168.1.1 

Computer Name: VIEWER1 
 
Ethernet  
card 1: 10.1.1.2 
card 2:  192.168.1.2 

Computer Name: VIEWER2 
 
Ethernet  
card 1: 10.1.1.4 
 

 
 
On the Server you would set up the Cimhosts file to talk to both viewers as follows: 
 

cimhosts.txt file 
 
SERVER_1 Cimhost.txt file 
 
10.1.1.1                 SERVER_1 
192.168.1.1 SERVER_1 
10.1.1.2                 VIEWER1 
192.168.1.2 VIEWER1 
10.1.1.4                VIEWER2 

VIEWER1 Cimhosts.txt file 
 
10.1.1.2             VIEWER1 
192.168.1.2      VIEWER1 
 
10.1.1.1             SERVER_1 
192.168.1.1      SERVER_1 

VIEWER2 Cimhosts.txt file 
 
10.1.1.1        SERVER_1 
 
10.1.1.4        VIEWER2 
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Appendix B: Name Resolution 
 
To ensure that the Primary and Secondary computers can resolve each other’s host names correctly, it 
is recommended that each name be configured in cimhosts.txt file on each computer.  Although 
CIMPLICITY HMI will also look at the regular Windows hosts file, the cimhosts.txt file takes precedence. 
 
The cimhosts.txt file resides in the CIMPLICITY HMI\HMI\etc directory in your CIMPLICITY HMI 
installation location. 
 
An example cimhosts.txt file might look like this: 
 
192.168.1.101  myprimary 
192.168.1.105  mysecondary 
 
NOTE:  
 
For systems with two network cards, please see Appendix A. 
 

Appendix C: Basic Troubleshooting 
 

1) Configuration mismatch between Primary and Secondary. 
 
a) Stop all of the projects running on the secondary. 
b) Delete everything from the secondary’s shared folder containing the CIMPLICITY HMI 

configuration data. 
c) Stop the Primary 
d) Update configuration 
e) Restart the project 

 
This eliminates the possibility of a configuration change being present on the Primary, but not the 
Secondary.  When they get out of sync in this manner, abnormal behavior is sometimes observed. 
 

2) System hangs on startup of UR_RP process in workbench. 
 

a) Verify that Accept Connections is selected under the CIMPLICITY Startup Options.  To 
verify, Open the CIMPLICITY Options, select the Startup Options tab and look at the Accept 
Connections.  If the box is not checked, select it. 

 
b) Verify that the required project folders (subdirectories) exist.  The following are required: 

 
Master (Should exist on the Primary only) 
Log 
Data 
Screens 
Scripts 
Lock 

 
If the Log or Lock directory is missing, it can be re-created.  If any of the other sub-
directories are missing, the project should be restored from a project backup. If the sub-
directories (except for Master) are missing from the secondary, please follow the steps 
above to recover. 
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3) The project immediately goes into dual master mode when starting Primary and 
Secondary. 

 
When the Primary and Secondary both start as Master, a $DUAL_MASTER alarm is generated 
and is visible in the alarm viewer.   This often occurs when the network connection between 
the primary and secondary was disconnected for at least a short period of time.  Normally, for 
this scenario, the two computers will recover without intervention. 

 
Three system global parameters control the behavior of the redundant servers’ 
communication and detection of the other’s failure.  If they are set too aggressively or are not 
set to the same values on both servers, each server will think that the other has failed and 
declare itself master.  The result will be a system that is constantly in dual master state, or 
constantly entering and leaving dual master state for no apparent reason.  If they are set too 
passively, detection of the partner’s failure will be slow. 

 
The system global parameters are: 
 
REDUND_PROBE_DELAY 
REDUND_PROBE_INTERVAL 
REDUND_PROBE_COUNT 
 
A good rule of thumb is that: 
 
REDUND_PROBE_DELAY * (REDUND_PROBE_COUNT + 1)  
 
should be greater than the time it takes to start the project.  Lower values will typically result 
in the systems starting up in dual master mode. 
 
For more information on configuration of these global parameters, please see Appendix F. 

 

Appendix D: Upgrading or Moving Redundant Projects 
 

1) When making significant network changes such as changing a computer name, significant 
network topology changes, etc. in a host redundant configuration: 

 
a) Stop the project 
b) De-select Server Redundancy from the Project Options 
c) Make the necessary network changes 
d) Update any related configuration files 
e) Re-select Server Redundancy from the Project Options 
f) Restart the project. 

 
2) When moving the project to a different computer with the same setup: 

 
a) Stop the project 
b) De-select Server Redundancy from the Project Options (this ensures that the old 

secondary is not required to open the workbench) 
c) Move the project 
d) Update any related configuration files 
e) Re-select Server Redundancy from the Project Options 

 
3) On project upgrade 

 
a) Read the Read Me or Important information documents 
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b) Turn off any auto start or start at boot settings for the project (under CIMPLICITY 
Startup Options. 

c) Stop the project 
d)  De-select Server Redundancy from the Project Options 
e) Make a backup of your project.  (Faciliates rapid deployment) 
f) (optional) Create a backup image of your hard drive with the current configuration. 

(This may loose your license for HMI if re-imaged, but will faciliate rapid deployment if 
required) 

g) Open the Workbench on the primary 
h) Perform the upgrade on the project. 
i) (optional) Test the behaviour of the project to ensure continued functionality of all 

scripts and CimView screens 
j) Recompile all compiled scripts and API’s 
k) Select Server Redundancy from the Project Options  
l) Verify and if necessary, correct the information under the Redundancy tab 
m) Start the project 
n) Test the behavior of the project to ensure it functions as expected. 
o) Stop the project 
p) Create backup of the project at this point (optionally removing the redundant 

configuration to make it more portable) 
q) Reconfigure auto start and start at boot options as originally configured 
r) Stop, backup, and upgrade viewers in a similar fashion. 
s) Be sure to test as often as possible during the change process to eliminate possible 

problems. 
 

Appendix E: Server Redundancy with Series 90 Triplex 
 
The runtime configuration of the PLC addresses for the CIMPLICITY Series 90 Triplex driver is stored in 
the GEF_CFG.INI file located in the Windows installation folder (i.e. C:\windows or C:\winnt).  A version of 
the file is also maintained in your project’s data folder.   
 
In redundant configurations, the GEF_CFG.INI file sometimes gets out-of-date on the secondary 
resulting in a failure to communicate with one or more PLCs from the secondary.  If the primary is able 
to communicate and the secondary cannot, copy the GEF_CFG.INI file from the primary’s Windows 
installation directory to the secondary’s Windows installation directory. 
 

Appendix F: Server Redundancy Global Parameters 
 
There are multiple global parameters that influence the behaviour of the Server Redundant 
Environment. These can be used for tuning purposes and for some enhanced behaviour. The list of the 
Server Redundant Global Parameters is as follows: 
 

� REDUND_PROBE_PORT 

� REDUND_PROBE_DELAY 

� REDUND_PROBE_COUNT 

� REDUND_PROBE_INTERVAL 

� SLAVE_STARTUP_TIMEOUT 

� REDUND_LINK_SLEEP 
 
Failover Rate Configuration 
 
The failover rate is the maximum amount of time it takes for the Primary and Secondary to realize a 
failure has occurred and to initiate the appropriate switching of Primary and Secondary. 
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The default value for the Server Redundant failover period is 20 seconds. It can be increased or 
decreased, depending on the needs of the application. Typically the default timing is acceptable for 
most systems. However, as systems get larger you will possibly want to increase these values. As well, 
the failover rate should never be modified to less than 3 seconds.  
 
The two servers, (Primary and Secondary) are doing pings to each other at the specified Ping Interval. 
This ping occurs by default on Port 4000 (TCP/IP). By default, if a response is not received to these pings 
by the fourth attempt the failover will be initiated. 
 
 

Server_2

TCP/IP Ping (port 4000 )

Server_1
 

 
The failover period is defined as: 
 
REDUND_PROBE_DELAY * (REDUND_PROBE_COUNT + 1) 
 
Since the default for REDUND_PROBE_DELAY is 5000 milliseconds (5 seconds) and the 
REDUND_PROBE_COUNT is 3, you can see that this is (5 * (3 + 1) = 20 seconds as the standard failover 
period. 
 
The two parameters, REDUND_PROBE_DELAY and REDUND_PROBE_COUNT are defined as project 
level global parameters.  
 
Adding the Project Level Global Parameters 
 
The formats for these parameters are: 
 
REDUND_PROBE_DELAY|3|<millisec> 
REDUND_PROBE_COUNT|3|<count> 
REDUND_PROBE_PORT|3|<tcp/ip port> 
SLAVE_STARTUP_TIMEOUT|1|<time in minutes> 
REDUND_LINK_SLEEP|3|<time in seconds> 
 
Where <millisec> is the number of milliseconds for the probe delay, <count> is the number of probes to 
make, and <tcp/ip port> for the two servers to ping each other on. 
 
Sample entries for these parameters would be: 
 
REDUND_PROBE_DELAY|3|5000 
REDUND_PROBE_COUNT|3|3 
 
A related parameter is REDUND_PROBE_PORT. This is the TCP/IP port number used to implement the 
probing mechanism. The default value is 4000. Only change this parameter if it conflicts with other 
software. 
 
REDUND_PROBE_PORT|3|4000 



 

15 

 
SLAVE_STARTUP_TIMEOUT – Please refer to Appendix H for further information. 
 
REDUND_LINK_SLEEP – Please refer to Appendix I for further information. 
 
 
For further information please refer to the Cimplicity Plant Edition help files on how to add global 
parameters. 
 

Appendix G: Cable Redundancy Router Entries (cimhosts.txt) 
 
The Cabling Redundancy capability is all configured in the cimhosts.txt file. There are several different 
things that can be configured via the cimhosts.txt file. The following explanation goes through most of 
the possible configuration with regards to Cable Redundancy. 
 
Failover Rate for Cabling Redundancy  
 
The default value for detecting that a network connection has been lost is 20 seconds. Due to the 
seamless nature of CIMPLICITY HMI HMI Computer Cabling Redundancy, this should be a reasonable 
default. It can be modified, depending on the needs of the application. The loss detection rate should 
never be modified to less than 3 seconds.  
 
The failover period is defined as: 
 
PING_INTERVAL * (PING_COUNT + 1) 
 
The two parameters, PING_INTERVAL and PING_COUNT are defined in the cimhosts.txt file. 
 
The formats for these parameters are: 
 
#PING_INTERVAL <seconds> 
#PING_COUNT <count> 
 
Where <seconds> represents the number of seconds between probe attempts and <count> is the 
number of probes to make. 
 
Example: 
 
Sample entries for these parameters would be: 
 
#PING_INTERVAL 2 
#PING_COUNT 10 
 
A related parameter is CONNECT_TIMEOUT. This is the number of seconds to wait after forming the 
TCP/IP connection for the initial data to arrive from the other computers. The default value is 10 
seconds. There should be no reason to change this value. 
 
TCP/IP Ports for Cabling Redundancy  
 
To support CIMPLICITY HMI Computer Cabling Redundancy, you need to use a set of TCP/IP ports in the 
range 5000 to 6000. Depending on other communication software you are running you might have to 
alter this range. This is controlled by the START_PORT_RANGE and NUMBER_OF_PORTS parameters in 
the cimhosts.txt file. 
 
The formats for these parameters are: 
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#START_PORT_RANGE <port> 
#NUMBER_OF_PORTS <count> 
 
Where <port> represents the TCP/IP port to start with, and <count> is the number of ports to use. 
 
Example: 
 
Sample entries for these parameters would be: 
 
#START_PORT_RANGE 5000 
#NUMBER_OF_PORTS 1000 
 
Diagnostic Output for Cabling Redundancy 
 
The CIMPLICITY HMI Computer Cabling Redundancy option can generate diagnostic output that you 
can use to track down problems with the functioning of the cabling redundancy system. To generate 
diagnostic output, enter a valid value for the DEBUG parameter in the cimhosts.txt file.  
 
The format for this parameter is: 
 
#DEBUG <flags> 
 
Where <flags> is a value used to control what types of diagnostic output to generate. 
 
You can add any of the following values together to form the <flags> value: 
 
Value Output 

1 Print errors 
2 Print infrequent calls 
4 Print all Winsock calls 
8 Print all transactions 
 
 

Appendix H: Auto Starting Redundant Projects on Boot  
 
On some occasions it is desirable to be able to have the redundant servers both start the project 
(Primary and Secondary) after reboot in order for the systems to be more fault tolerant. To do this you 
will need to do configure the project via the Cimplicity Options to “Start on Boot”. On the primary 
system you would point this to the location where you have the Primary copy of the project. On the 
secondary system you would point to the location where you have the shared folder that contains the 
secondary copy of the project. This means that whenever the computers start they will automatically 
start both the primary project and the secondary project.  
 

1) Open up “Cimplicity Options” on the Primary Server 
2) On the “Startup Options” tab add the project (local) to the System boot options list. 
3) Open up the “Cimplicity Options” on the Secondary Server 
4) On the “Startup Options” tab add the project from the Secondary share to the System Boot 

Options list. 
 

NOTE:  
 
You use the <PROJECT>.GEF file from the secondary share when you are adding this where 
<PROJECT> is the name of your project.  
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SLAVE_STARTUP_TIMEOUT 
 
It is possible to delay the start of the project on the Secondary system after the boot by using the 
global parameter SLAVE_STARTUP_TIMEOUT. This will actually put a delay from the time the system 
has started to the time it actually attempts to start the project on the secondary. 
 

Primary

Secondary

System 

Boot

Launch Project

Launch ProjectSLAVE_STARTUP_TIMEOUT

Time

 
Global Parameter: SLAVE_STARTUP_TIMEOUT 
Value:<delay in minutes> 
System or Project: Project 
 
Where <delay in minutes> is the amount of time to delay the actual starting of the project on the 
secondary after boot. By default the value is 0 minutes. 
 
To configure this you add this PROJECT level global parameter to the workbench on the primary 
system and do a configuration update. This global parameter will get copied across to the secondary 
share when the configuration update is complete.  
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Appendix I: Delaying Communication Link to Secondary on Project 
Startup 
 

Primary

Project

Start

Attempt 

Connection to 

Secondary

REDUND_LINK_SLEEP

Time

 
REDUND_LINK_SLEEP 
 
It is possible to delay the connection to the secondary between the processes after the project has 
started. This is configured by the System level global parameter REDUND_LINK_SLEEP. There may be 
some further startup that you wish for the project to do on the primary before it attempts to establish 
the connection to the secondary on startup. This may be used in order to give the Primary system 
more time to get into a stable position with regards to CPU utilization or resource usage. 
 
Global Parameter: REDUND_LINK_SLEEP 
Value: <delay in seconds> 
System or Project: System 
 
The default value is 5 seconds. 


